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Introduction 
 
AASHTOWare Project Estimator is used by KYTC to create cost estimates, also known as field 
estimates, for projects.  This manual is not a comprehensive manual of all potential uses for and 

aspects of Estimator nor does it contain keyboard commands 
or information about prices.  The focus is of this manual is on 
the instruction of design personnel to prepare and edit 
estimates for submission to Highway Design.  Construction 
Procurement personnel will import the same Estimator file 
directly into AASHTOWare Project to initiate the process of 
creating projects and proposals.  The basic contract 
information along with the bid items and their quantities and 
prices are quickly and accurately transferred, eliminating the 
need to manually key that information into AASHTOWare 

Project which eliminates data entry keying errors in bid item codes and quantities.  Therefore, it is 
very important to ensure that the information on the estimate is correct.  The estimate bid item 
codes and quantities should be compared with the same information on the project plan sheets.  All 
differences between the information on the plans and corresponding estimate must be resolved so 
that the data in the estimate and plans agree exactly and accurately represent what the project 
designer wants constructed in the field.   
 

Mouse Setting 
 

BEFORE you begin working in Estimator, ensure that the Snap To mouse function is turned off on 
your computer.  If this setting is not turned off, you will have annoying issues with Groups and Bid 
Items changing location every time you click on them. 
 
 Navigate to Control Panel on your computer. 
 Select Hardware and Sound. 
 Select Mouse. 
 Click on the Pointer Options tab.  
 Uncheck the Snap To box before Automatically move pointer to default button in dialog 

box. 
 Click 

Apply 
button.  

 Click OK. 
 
Depending on 
your computer and 
version of 
Windows, your 
screen may look 
different than this 
image and the 
steps may be 
slightly different.  However, the basic information is applicable to all systems and the Snap To 
function control switch is located somewhere in your computer’s mouse properties. 
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The Estimator Interface 
 
The Estimator interface displays three Panes: the Tree Pane (left), the Information Pane (upper 
right), and the Spreadsheet Pane (lower right).   
 

 
 
 
The Tree Pane on the left of the screen displays the structure of the various groups in the project.  
Contained within the group folders are the bid items along with their bid history.  Each folder can be 
opened to reveal the bid items contained within the folder.  When different selections are made in the 
Tree Pane, the corresponding data displayed in the Information and Spreadsheet Panes on the right 
side of the screen will change for each selected item. 
 
The Information Pane on the upper right is a form-like window that allows you to enter data about 
the estimate, group, or bid item.  The information displayed varies depending upon the selection that 
was made in the Tree Pane. 
 
The Spreadsheet Pane on the lower right is a table that allows you to view the different attributes of 
the group or individual item.  Information can also be entered from the table by entering the data in 
the cells.  This view is also dependent upon the selection made in the Tree Pane. 
 

 Button in the Spreadsheet Pane will step into the child item or group in the Tree Pane, which 
also changes the corresponding data in the Information and Spreadsheet Panes. 

 
 Switches to the previously highlighted Tree node. 

 
 Switches to the parent of the current highlighted Tree node. 

 
 Move forward in the highlighted Tree node set. 
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CATALOG UPDATES (KYTC Personnel) 
 

These instructions only apply to KYTC personnel.  Instructions for consultant catalog updates 
follow in the next section.   
 
Updated catalogs are made available approximately every quarter because new bid items are created 
and current ones revised or made obsolete on an ongoing basis.  If you have never used Estimator and 
no catalog is associated with your version of Estimator, the process will begin automatically the first 
time you open Estimator.  If the catalog search feature is set to look for catalogs, as it should be, this 
process will automatically take place every time you open Estimator.  Instructions to ensure that this 
process is automatically taking place are next.   
 
NOTE: For this process the Estimator program is open but no Estimator file can be open or 
there will be no access to catalog update menus. 
 
AUTOMATIC CATALOG UPDATE SEARCH 
 
Estimator will automatically check for new catalog updates each time you open it if the default 
setting is maintained.  If Estimator finds a new available catalog you will get the following 
message.   
 

 
 

 Click Yes.  Be sure you do not check the box beside Disable this feature.  The next pop-up 
appears. 

 

 
 

 Select the latest catalog and click Next. 
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The following pop-up appears. 
 

 
 

 Click Next and the following pop-up appears. 
 

 
 

 Click Finish. 
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To ensure that Estimator is searching for new catalogs each time the program is opened, perform the 
following steps before opening any Estimator files. 
 
 Select Other Tools on the tool bar. 

 
 Select Global Options. 
 

 
 
 
 
 
 

 Click on the Internet tab on the pop-up menu. 
 

 Ensure that the box is checked beside Automatically Search for Catalog Updates on 
Startup.   
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MANUAL CATALOG UPDATE SEARCH 
 

You can manually search for catalog updates as well.  Using the latest catalog will make the process 
easier with more accurate pricing because new bid items are added and existing ones made obsolete 
on an ongoing basis.   

 
 Click on the Catalog Tools tab on the tool bar. 

 
 Select Check for Catalog Updates. 

 
 

 
 

 Click on the Next button. 
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 Check the box beside the most current catalog to import from the list and then click Next 
and follow the rest of the catalog wizard prompts, which are the same as those shown above 
in the section on automatic updates.   

 

 
 

 Click Next on all of the prompts and finally Finish. 
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CATALOG UPDATES (CONSULTANTS) 
 

These instructions apply only to consultants.  KYTC personnel catalog update instructions are 
covered in a previous section. 

Consultants are not connected to the KYTC server so none of the catalog updates can take place 
automatically.  Consultant catalog updates must be performed manually.  

Find the catalog path in your Estimator program.   

 Open Estimator but do not open an estimate. 
 

 Click on the Other Tools on the tool bar. 
 
 Select Global Options from the drop-down menu. 

  

 

 Click on the URLs Tab. 
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 Take note of or copy the location of the Estimator catalogs in Catalog Path (HTTP or file). 
 

 

 Navigate to the Highway Design website:  
 
http://transportation.ky.gov/Highway-Design/Pages/Software-and-Support.aspx 

 Find the latest catalog posted. 
 

 Click on the catalog and select Save As from the drop-down menu. 
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At this point, you will save the catalog to the catalog path you located earlier in the Estimator.  See 
instructions elsewhere to AUTOMATICALLY OPEN TEMPLATE WITH CURRENT 
CATALOG. 

 

DELETE OBSOLETE CATALOGS 
 

On your computer, navigate to C-drive/Program Data/Estimator/catalogs.  Select any catalogs 
you wish to remove and delete them.  Your Estimator program will no longer access those catalogs. 
 

 

AutoSave Function 
Estimator has a default setting to AutoSave the file as you are working on it.  To change the amount 
of time between automatically saving your files, close any open documents. 
 
 Select Other Tools on the toolbar at the top of the screen. 

 
 Select Global Options. 
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The next pop-up appears: 
 

 
 
 Use the up or down arrows to change the minutes. 

 
 Click Apply. 

 
 Click OK. 
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UPDATE PRICE INFORMATION 
 

INTRODUCTION 
 

Following the instructions in the catalog update sections of this manual will change the estimate bid 
items to the new catalog but not the prices.  Therefore, when an existing estimate is updated to a new 
catalog, it is also necessary to manually update the prices already contained in an estimate with the 
prices contained in the newly associated catalog.  Bid items already contained in the estimate prior to 
the catalog update will continue to use the previous catalog as the source catalog for the bid item 
prices unless the user follows these instructions to update price information to reference the newly 
attached catalog as the source catalog for all the bid item prices.  After you have changed the source 
catalog of the estimate to the most current catalog file available, you need to make sure all catalogs 
are closed except for the source catalog.   

 
 Click on Catalog Tools. 

 
  Select Close Catalog. 

 

 
 

 On the Close Catalog dialog box, select the catalog that is not the current source catalog 
for the estimate.  
 

 Click OK. 
 

 
 

 Repeat the step above to close all open catalogs other than the current source catalog for 
the estimate.  You can only highlight and close one catalog at a time. 
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You can choose to update the entire estimate by highlighting the estimate title, a selected group by 
highlighting the group or a selected item within a group by highlighting that item.  In most cases, you 
will want to update the prices for the entire estimate. 
 

 Highlight the estimate name. 
 

 
 

 Select Edit. 
 

 Click on Update Price Information. 
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 On the Update Selected Price Information dialog box, select the second radio button for 
Refresh Time Dependent Data:.   
 

 Click OK. 
 

 

 

All bid items with a bid item history in the new catalog will be updated.  You can check the source 
catalog of a bid item by expanding the bid item in the tree pane, highlighting the Bid History 
Regression for the bid item and checking the source catalog in the information pane. 

 

 

 

 Save your changes. 
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INSTRUCTIONS FOR WORKING WITH AN EXISTING ESTIMATOR FILE 
 

For existing Estimator files, perform steps 1-3 below and then skip to step 5. 

1. SAVE THE FILE 
 

 
 

Save the .est file from the source to the location where you want to keep the version you will be 
modifying.  If the file comes from ProjectWise or is attached to an email, click on the file to open it, 
and the Estimator program will start.  Because you are not opening the file from the Estimator 
program, Estimator will require a password to open the file, which is always “password” in all lower 
case letters.  If opening the file from ProjectWise, be sure you do not already have the Estimator 
program open or the file will not open.  The User Name field will be automatically populated Admin. 

 

 
 

You will get the message Cannot open catalog if the Estimator program is not using the same catalog 
as the one the estimator file was created with.  Click OK and keep going.  The file will be a Read-
Only document, but that will not affect your work, because you will save the document for your own 
use and add the current catalog which will make the file active and you will be able to edit it.   
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 Under the File tab, select Save As. 

Save the file with the name and in the location on your computer you want.   
 

 
 

 Close the file and the Estimator program.   
 

NOTE: The Save function only saves the current version of the Estimator file in the current 
location.  Save As saves a new version and gives you the option to change the name of the file in 
a new location. 

 
2. OPEN THE FILE 
 

After you have created the file, always open Estimator first and then open the file from the Open 
function under the File tab.  Do not open the file by clicking on the file itself, or it will be a Read-
Only document that cannot be modified.   
 
 Open the Estimator program by clicking on the Estimator icon on your desktop. 

 

 
 
 Under the File tab, select Open and find the file you saved.  Be sure you do not select Import 

File.  This function is for importing Excel files and is be covered later in an addendum. 
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The next screen after selecting Open is a local Windows computer interface which will allow you 
to locate the Estimator file.   
 
NOTE: PDF’s of an Estimator file cannot be opened by Estimator. 

 

 
 

3. SELECT THE MOST CURRENT CATALOG 
 

Verify that the most currently available catalog is being applied to the estimate regardless of which 
catalog was used to build the estimate. 
 
 Click the Edit tab. 
 
 Choose Estimate Options. 

 

 
 
 
 
 
 Choose Catalog. 
 
 Select the most recent catalog which will have the 

format KYTC_YEAR-MONTH-SY2008, for example, 
KYTC_2018-01-SY2008. 

 
 Click OK. 
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NOTE: You can open multiple Estimator files at the same time.  However, when you open two 
or more Estimator files at the same time, all of them must have the same catalog associated 
with them.  If all of the open Estimator files do not have the same catalog before they are 
opened, they will all lock-up as Read-Only files.  You cannot successfully change the catalog on 
the Estimator files while they are open simultaneously.  Open one of the files and change the 
catalog to match the one you want to use and save it.  Close the file and make sure perform the 
same function for all of them you want to work on.  Finally, open all of the files from Estimator 
and proceed to work. 
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INSTRUCTIONS FOR CREATING A NEW ESTIMATE FILE 
 

Perform step 4 and proceed through the rest of the steps.   
If working with an existing Estimator file, skip step 4 and proceed to step 5. 

4. CREATE A NEW ESTIMATE 
 

 Open the Estimator program. 
 

You can start to create a new estimate in one of two ways: 
 
 Click on the File in the upper left corner of the tool bar and choose New, or 

 

 
 

 Click on the NEW icon  . 
 

 
 

 A dialogue box appears with two choices, <Blank Estimate> and Highway Design 
Estimator Template.  Select Highway Design Estimator Template and click OK.   

 
NOTE: DO NOT EVER USE <Blank Estimate>. 
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The template appears and is ready for data entry and modification for the specific project estimate. 
 

 

 

Even though you may have updated the catalog to the most current version, the Highway Design 
Estimator Template will point to the last catalog that was associated with it until it is modified.  If 
you have deleted that old catalog, you will get the Cannot open catalog message immediately after 
you select the Highway Design Estimator Template because the template is looking for the 
previous catalog that is no longer available for the template to use.   
 

AUTOMATICALLY OPEN TEMPLATE WITH CURRENT CATALOG 
 
To make the Highway Design Estimator Template open automatically with the current catalog 
after a new catalog has been made available: 

 Open the Estimator program but do 
not open any Estimator files. 
 

 Click on File and select Open. 
 

 
 
 Select file type Estimate Template Files (*.ETM) but do NOT click Open. 
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 Click on the Computer icon on the left. 
 

 Select the OS Disk (C) drive. 
 
 Click Open. 
 

 
 

 Select Program Data and click Open. 
 

  
 

 Select Estimator and click Open. 
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 Select templates and click Open. 
 

 
 
 Select Highway Design Estimator Template.etm and click Open. 

 

 
 

 A new estimate template appears on the screen.  Click the Edit button and select Estimate 
Options. 
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 Select the catalog you want and click OK. 
 
 

 
 Click File and then Save. 
 

 
 

 Close Highway Design Estimator Template.etm. 
 

 Each time a new template is opened it will have the catalog you associated with it. 
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5. COMPLETE THE FORM 
 

Ensure that the various fields in the Information Pane (upper right half of the screen) have been 
completed appropriately, or fill them in as follows: 

 

 
 

FIELD NAME INSTRUCTIONS / EXAMPLES are in Bold 

ESTIMATE Typically, the Six-Year Plan (SYP) number is utilized at this point for the name of 
the estimate file.  The screen images uses throughout the rest of this manual show 
the naming protocol utilized by Construction Procurement. 

SPEC YEAR Auto-populated 08 even though this is not the actual current spec year. 
LETTING DATE Use the drop-down calendar menu to the select letting date for which the project is 

scheduled.  Do not use a date more than one year from the current date as this will 
affect the bid item prices. 

UNIT SYSTEM E = English (default) or M = Metric 
LATITUDE OF 
MIDPOINT 

From plan sheets or use Google Earth to find approximate project midpoint: 
(ddmmss) 372204 

LONGITUDE OF 
MIDPOINT 

From plan sheets or use Google Earth to find approximate project midpoint: 
(dddmmss) 0863622 

GPS LATITUDE 
OF MIDPOINT 

Leave blank.  It will auto-populate if you delete and re-enter data into the 
LATITUDE OF MIDPOINT field above.  This field is not required in 
AASHTOWare Project. 

GPS LONGITUDE 
OF MIDPOINT 

Leave blank.  It will auto-populate if you delete and re-enter data into the 
LONGITUDE OF MIDPOINT field above.  This field is not required in 
AASHTOWare Project. 

FEDERAL/STATE 
PROJECT # 

Funding number from plan cover sheet.  It may have changed from a design 
number. federal: STP BRZ 0124; state: FD04 083 0036 124-125  

DO NOT USE This is a field that is used by other states but not by KYTC at this time. 
DEFAULT FUND 
PACKAGE 

Leave blank. 

DESCRIPTION Route name and number, left align, all caps.  Limited to 60 characters including 
spaces.  If printing an estimate, temporarily change the setting to center align. 
HINKEY ROAD (US 36)   

SOURCE 
CATALOG 

Automatically displays the current catalog in use on the estimate. 

WORK TYPE Choose from drop-down menu.  If the required selection is not available in 
Estimator, it can be modified after the file has been imported into AASHTOWare 
Project.  Many of the descriptions appear to be duplicated but with the words in a 
different order such as Bridge with Grade & Drain or Grade & Drain with 
Bridge.  The section or group with the most money should come first in the 
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6. EDIT GROUPS 
 

In Estimator, the term Groups is the same as Categories and Sections in AASHTOWare Project.  Use 
only the Highway Design Estimator Template.  It has twenty available groups, but it is unlikely 
that every group will be required for any individual project.  Only the groups containing bid items 
should be retained.  The order of the Descriptions in the template is the order that should be 
maintained and mirrors the order in AASHTOWare Project.  Many times the original estimate file 
creator will have changed the order or re-named the descriptions due to uncertainty about the 
appropriate category for some of the bid items.  The group descriptions should be in the following 
order with the exact description: 

 
GROUP  DESCRIPTION FOR BID ITEM TYPE 

0001 PAVING Items from the Paving Summary plan sheet 
0002 ROADWAY Items from the General Summary plan sheet.  The 

majority of the bid items are usually in this category. 
0003 DRAINAGE Items from the Pipe Drainage summary plan sheets 
0004 BRIDGE Items from the Structures plan sheet 

 

Each bridge on a project requires a separate group.   
 

Each bridge bid item must be specified.  There is not 
a lump sum bid item for bridges.   
 

The bridge description should be extended to include 
location information and drawing number:  
BRIDGE – CLINTON CREEK – DWG. 16945 
 

NOTE: This category is also used for culverts. 
0005 UTILITY Items from the Gas line relocation or Electrical or 

Communication Utility plan sheets. A supplemental 
description should be added:  
UTILITY – GAS LINE RELOCATION. 

0006 SEWER Items from the Sewer line plan sheet 
0007 SIGNING Items from the Signing plan sheet (Bid item 02562 

Temporary Signs goes in ROADWAY) 
0008 SIGNALIZATION Items from Traffic Signal plan sheets 
0009 LIGHTING Items from Lighting plan sheets 

description.  So that if the estimate cost for the Roadway group is higher than the 
Bridge group, the correct description is Grade & Drain with Bridge. 

HIGHWAY TYPE Choose from drop-down menu. 
URBAN/RURAL Choose from drop-down menu. 
SEASON Choose from drop-down menu. 
COUNTY Choose # from drop-down menu.  Do not type in entry or the file will not import. 
DISTRICT Choose # from drop-down menu.  Do not type in entry or the file will not import. 
DO NOT USE This is a field that is used by other states but not by KYTC at this time. 
DO NOT USE This is a field that is used by other states but not by KYTC at this time. 
ESTIMATE COST Auto-populated from bid item prices in file. 
CONTINGENCY % Auto-populates 10 or enter 15 if the construction estimate is less than $1 million. 
ESTIMATE TOTAL Auto-populated based on bid item cost and the contingency percent. 
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0010 TRAFFIC LOOPS Items involving traffic loop wire installed in road 
0011 INTELLIGENT 

TRANSPORTATION 
SYSTEMS 

Items for ITS systems  

0012 WATERLINE Items from Waterline Relocation plan sheet 
0013 LANDSCAPING Items from Landscaping plan sheet 
0014 MOWING * 
0015 BLANK * 
0016 UNKNOWN FOR 

ESTIMATOR 
* 

0017 MISCELLANEOUS * 
0018 TRAINEES * 
0019 DEMOBILIZATION 

&/OR 
MOBILIZATION 

Only 02569 DEMOBILIZATION and 02568 
MOBILIZATION go in this group 

0020 WARRANTY * 
 
*TYPICALLY NOT APPROPRIATE FOR USE.  In particular, the MISCELLANEOUS 
group tends to be used by estimate designers unfamiliar with the process, but this category is 
seldom required as there is usually an applicable group choice.  TRAINEES and WARRANTY 
groups may be added to the project/proposal in AASHTOWare Project by Construction 
Procurement advertisement personnel, but they should not be included at this level of estimate 
design.   
 

NOTE: The Estimator program utilizes familiar Windows-type Cut, Copy, Paste, and Click-
and-Drag functions. 

 
Re-number and rename the groups 

 Click on the left side of the screen on the group to be edited, for example, Group 0001 
PAVING.  On the right screen, make any edits to the number or description.  Group numbers 
are always four digits but are not automatically associated with a specific description.  For 
example, DEMOBILIZATION &/OR MOBILIZATION will always be the last group 
whether there are two groups or ten, so in those examples it would be number 0002 or number 
0010 depending on the total number of groups.  Be sure to use the exact group description 
name correctly spelled and in all capital letters or the file will not import into AASHTOWare 
Project.   

 

 
 

After the file has been exported as an “xml” file, another program, “Fix Estimator XML”, is run on 
the .xml file to add the required section codes.  The Fix Estimator XML program will not recognize 
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non-standard descriptions and, therefore, will not able to assign the required section code.  Without 
the correct section code, the file will not upload into AASHTOWare Project, so it is very important 
that the group names are accurate.  Fix Estimator XML does not flag errors so the issue will not be 
apparent until Construction Procurement staff try to import the file into AASHTOWare Project. 
 

Delete unused groups except for those that will be needed later.  Even if the bid items for 
structures or waterlines have not been provided yet, it is a good idea to keep those groups so 
the section order and numbering will be correct in AASHTOWare Project when they arrive. 
 

 Right click on the group name in the left side of the screen.  From the drop-down menu select 
Delete Group.   

 
 

 
 
 

Add missing groups for example, when there are multiple bridges, culverts or paving 
alternates.   
 

 Right click on the group name in the left side of the screen.  From the drop-down menu select 
Insert Group.  A group that is added will automatically be populated at the bottom of all the 
existing groups with the last group number.  Put it in sequence with the order of the table 
above. 
 

Be sure to re-number the remaining groups so that they are in consecutive numerical order with no 
gaps in the sequence of numbers.  Neither Estimator nor AASHTOWare Project will accept 
duplicate group numbers, but group descriptions can be repeated as needed, for example, for multiple 
bridges or paving alternates.   
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Below is an example of correctly edited groups based on the information above: 
 

 
 
 

7. EDIT BID ITEMS 
 

 

 

Bid items may be in the wrong group, in the wrong order, or missing. 
 
Adding Bid Items 
 

There are two ways to add new bid items to an estimate, using the Add Item function or entering 
the item in the group items view of the Spreadsheet Pane. 
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Add Item Function: 
 

 Right click on the group where the bid item should be. 
 

 Choose Add Item from the drop-down menu. 
 

 
 
After selecting Add Item, a blank item template appears in the Information Pane: 
 

 
 

The fields on the right side of the screen should be completed as follows: 

FIELD NAME INSTRUCTIONS / EXAMPLES 
LINE NUMBER Auto-populated with an incremental number when 

Add Item function is used 
ITEM Enter the bid item code with a minimum of five 

digits.  Use “0’s” at the beginning of any number 
that is less than five digits: 00001 for DGA BASE. 
 

Item numbers can be selected from the drop-down 
menu using the arrow button: . 
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Item numbers or descriptions can also be searched 

for using the find item button: .   
 

Wildcard search can be performed.  Use “*” for 
multiple characters and “?” for a single character. 

QUANTITY Enter the total quantity to be used. 
UNIT PRICE If there is a bid history on the item number 

entered, the price will be auto-populated from the 
catalog after the quantity has been entered.  If 
there is no bid history, enter the price from the 
previous year’s average unit bid price.  A price 
must be entered. 

PRICE SOURCE Auto-populated 
EXTENSION Auto-populated 
FUND PACKAGE Leave blank. 
DESCRIPTION Auto-populated by the bid items code if the item 

exists in the current catalog.  DO NOT MODIFY 
this description.  Modifications will not import 
into AASHTOWare Project and that information 
will be lost.  Any special information should be 
entered into the Supplemental Description field.  
If the bid item does not exist, see directions below 
to enter bid items not found in the catalog.   

SUPPLEMENTAL DESCRIPTION Use if needed.  See Supplemental Description 
below. 

NOTES TAB Do not use.  See Notes Tab below. 
ALTCODE Ensure this field is blank.  See ALTCODE below. 
UNIT Auto-populated unless the item is not in the 

current catalog.  Use the drop-down menu to enter 
the correct unit if it does not auto-populate. 

FIXED PRICE ITEM Check box only on: 
02600 Fabric Geotextile TY IV for Pipe 
10020NS Fuel Adjustment 
10030NS Asphalt Adjustment 
10203ND Pavement Adjustment 

OBSOLETE ITEM Leave blank. 
HYBRID LUMP SUM ITEM Auto-populated. 
EXCLUDE FROM REFERENCE PRICE 
CALCULATIONS 

Leave blank.  Delete the check mark if there is 
one. This function very seldom used. 

FROM GROUP DEFAULT Ignore. 
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Enter a Bid Item Code Not Found in Catalog but is an active code in AASHTOWare Project you 
may need to change the setting shown below to allow the unrecognized bid item to be entered:  

 
 Click Edit on the tool bar and choose Estimate Options. 

 

 
 
 

 Uncheck the box before Only Trns*port Items, Codes and Rounding Levels Allowed if it 
has been checked. 
 

 Click OK. 
 

Add a Supplemental Description 
 

Some items require a supplemental description in 
AASHTOWare Project, and others need additional 
information to further clarify the item’s intended 
use or for more detail.  Bid item 02545 Clearing 
and Grubbing, for example, is required to have the 
acreage involved included in the description as 
shown in the image below.  Sometimes there are 
duplicate items needed for different uses which 
should not be combined.  Also, utility bid items 
typically have specific details that the basic item 
description does not cover.  This information can be entered at the estimate level and imported 
along with the rest of the bid item information.  See the Addenda for a complete list of bid items 
that require a supplemental description.  Again, use all capital letters in the supplemental 
description. 

 
 Make sure that the ALTCODE field is blank.  Any data in this field will prevent the file 

from importing into AASHTOWare Project. 
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NOTE: Do not enter any bid item information in the field under the Notes tab.  Any information in 
this field will prevent the Estimator file from importing into AASHTOWare Project. 

 

 
 

To Add Bid Item using the Spreadsheet Pane 
 
Another method for adding new bid items it to add to them to the list of bid items within a group 
folder by entering them after the last bid item in the list on the Spreadsheet Pane on the lower right. 
 
 Highlight the group on the Tree Pane where you want to add a new bid item. 
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 Use the scroll bar tool on the right of the Spreadsheet Pane to scroll down to the last bid 
item.  There will be one additional bid item row below the last bid item entered. 

 

 
 

 The Line # will auto-populate when entries are made in the following fields. 
 

 Entering the bid item code across the same row under Item and the Quantity across the row.  

 

 Use the right arrow button to access the other column fields if you need to enter a 
Supplemental Description. 
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After entering the Item code, Quantity and Price the rest of the column fields will auto populate 
as they do when entering the data in the Information Pane using the Add Item function. 

 

 

Move a bid item to the appropriate group:  
 

 Click the + beside the group folder where the bid item is located and the destination group on 
the left side of the screen if they are not open.  If there are no bid items in a group, there will 
not be + sign beside the folder icon. 
 

 Click and drag the bid item to the group.  It can be placed in bid item numerical order.  Drop 
in the item above the item where it should appear.  If you drop it on the Group ID, the item 
will be automatically added to the bottom of the bid items in that group. 

 
Re-order the bid items 
 
Bid items do not have to be in numerical order for importing the estimate file into AASHTOWare 
Project to work properly because AASHTOWare Project will automatically put them in order within 
each category.  However, it makes it easier to 
locate bid items from the plans if the bid item 
codes are in numerical order on the estimate. 
 
 Click and drag each individual bid item 

into the desired order, or 
 

 Click on one of the group folders in the 
Tree Pane.   

 
 Click on the Item header button in the 

lower right Spreadsheet Pane until the 
items are in the desired order (smallest 
number to largest).  At this point, the 
change will only appear in this pane. 
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 Click on the Edit button and select Renumber Using Current Order. 
 

 
 

 All of the bid items on the estimate are now in numerical order by bid item code within each 
group. 

 

 
 

Add a Reference Price to Mobilization and Demobilization  
 

 Select the bid item for Mobilization or Demobilization in the Tree Pane.  Be sure the 
quantity is set to 1 in the Information Pane. 
 

 Right click on the item in the Tree Pane and select Add Reference Price from the pop-up 
menu. 
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In the Information Pane:  
 Enter a Reference Price description, either DEMOB 1.5% or MOB 5% 

 
 Put a check beside the Percent of Estimate. 

 
 Enter the appropriate percentage amount (Mobilization = 5.0 percent; Demobilization = 1.5 

percent) in the field beside the Percent of Estimate checked box. 
The Unit Price field will populate according to the percent you specified for the item.   

 
 

 

 Save this change. 
 
Final Checklist 

 
1. Ensure that you are using the most recent catalog. 

 
2. When creating a new estimate always use the Highway Design Estimator Template.  

NEVER use the <Blank Estimate>. 
 

3. Always use the drop down menus to select the appropriate Work Type, Highway Type, 
Urban/Rural Type, Season, County and District in the upper right Information Pane.  
NEVER type this information into these cells or the data will not be recognized when it is 
time to import the file into AASHTOWare Project. 

 
4. The contingency is either 10% for project estimates over $1 million or 15% for projects 

under $1 million. 
 

5. The Project Description must be in ALL CAPS, left aligned and no more than 60 characters 
and spaces in length. 
 

6. Group descriptions must be in ALL CAPS and named exactly as they appear in the template 
and spelled correctly.  DO NOT create new group descriptions that are not on the template.  
There is no STRIPING or MOT group.  Striping and bid items for MOT belong in the 
ROADWAY group.  Also, groups should remain in the same order as the template.   
 

7. Group descriptions can be repeated as needed for multiple bridges and/or culverts on a 
project.  After the standard group name add a space and hyphen and then proceed with 
unique identifying information.  See the example above at the end of step #7. 
 

8. Delete all groups that do not contain any bid items.  Re-number the remaining groups so 
they are in correct numerical order and there are no gaps in the number sequence. 

Check box for Percent of 
Estimate. 

Enter Reference Price 
description. 

Enter the percentage 
amount. 
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9. Do not modify the bid item description.  Use the supplemental field for additional bid item 
information.  Supplemental descriptions must be in ALL CAPS. 

 
10. Ensure that all bid items have quantities, units and prices.   

 
11. Remember that for all bid items with a unit of Lump Sum the quantity can only be one even 

if there are more than one of the same item.  Any lump sum bid items with multiple 
quantities, for example 02651 DIVERSIONS (BY-PASS DETOURS) or 02731 REMOVE 
STRUCTURE, must have those items broken out into individual bid items.  If there are four 
Diversions on a project there will be four individual Diversion bid items with Supplemental 
Descriptions to uniquely identify each. 
 

12. Never use the Notes tab or the AltCode field on individual bid items as this will prevent 
import success. 

 
13. Ensure that the unit price for 02600 FABRIC GEOTEXTILE TY IV FOR PIPE is exactly 

$2.00. 
 

14. Ensure the box checked for Fixed Price Item on 02600 FABRIC GEOTEXTILE TY IV 
FOR PIPE, 10020NS FUEL ADJUSTMENT, 10030NS ASPHALT ADJUSTMENT and all 
10203ND PAVEMENT ADJUSTMENT bid items. 

 
15. Bid Item Code 10020NS FUEL ADJUSTMENT and 10030NS ASPHALT ADJUSTMENT 

should only be in the ROADWAY group.  The unit price is always $1 for both items.  
Sometimes the price and the quantity get placed in the opposite fields. 
 

16. Bid Item codes 02568 MOBILIZATION and 02569 DEMOBILIZATION should only be in 
the DEMOBILIZATION &/OR MOBILIZATION group and NEVER in the ROADWAY 
group.  These are the ONLY two bid codes that go into the DEMOBILIZATION &/OR 
MOBILIZATION group. 

 
17. MOBILIZATION is only used on contracts over $2,000,000. 

 
18. MOBILIZATION is always 5% and DEMOBILIZATION is always 1.5% of the estimate. 
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8. VERIFY THE ESTIMATE 
 
The final step before exporting the file is to verify the estimate. 

 
 

 Click on the Edit tab and choose Verify Estimate (above), or 
 

 Use the Verify button on the toolbar at the top of the screen (below). 
 

 
 

 A report log will generate showing all of the potential issues on the estimate which may 
interfere with successfully importing the estimate.   
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After running the Verify Estimate function, the Tree Pane has tiny warning symbols ( ) beside 
each category with a bid item containing potential issues as well as the individual bid items with 
issues.  You can go directly to an individual error by double-clicking on the error row in the Verify 
Estimate log. 

 

 

 

Common Error Messages 
 
Some, but not all, of these errors are legitimate problems that will prevent the file form being 
imported. 
 
“The Estimate Contingency is non-zero …” The default percentage is 10%.  This percentage has 
to be manually entered into AASHTOWare Project so this error will not prevent the file from 
importing.  However, there should still be a number in this field in the estimate file.  This error 
message is not a problem that requires any correction. 
 
“The validity of this item [ITEM CODE #####] is questionable because a corresponding catalog 
item could not be found.”  If this message occurs for a bid item in the estimate that is a currently 
used bid item in AASHTOWare Project, the estimate will still upload because AASHTOWare Project 
will recognize the item.  This warning is may be caused by bid items that have been added but have 
not been used enough, are brand new or you have not added the most recent catalog to your Estimator 
program.  However, if this is an obsolete bid item in AASHTOWare Project, the file will not upload 
correctly. 
 
“The Item Unit is blank.” “The Item Code is blank.”  All required fields must be completed 
including units and prices.  
 
“The required Item Supplemental Description is blank.” Enter a supplemental description as 
covered elsewhere in this manual. 
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Although it will not show up as an error in the 
Verify Log report, AASHTOWare Project will 
not upload the file if the Description of the 
route field is blank.  Also, the description 
cannot exceed 60 characters including spaces.  
When printing a hard copy of the estimate, this 
field should be center aligned so that it lines up 
properly with the other data.  For the purpose 
of importing, however, it should be left aligned because the center alignment uses up the character 
limitation in AASHTOWare Project.   
 
After addressing all of the issues, re-run Verify Estimate and use the Save As function under the 
Edit tab to retain the changes. 
 
 
9. PRINT 
 
If needed, you can either preview the Estimator file print job in Crystal Reports or print a hard copy. 
 
Print Preview 

 
 Click File. 

 
 Select Print Preview. 
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On the next pop-up make sure Show Item Descriptions, Show Inactive Price Bases, Portrait and  
Print using Crystal Reports are selected as shown below. 
 
 Click OK. 

 

 
 
A Crystal Reports viewer will show what the printed copy will look like.   
 

 
 
You can view each page in the document using the arrow buttons. 
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You can review and then go back to make any needed corrections to the Estimator file before printing 
a hard copy of the file. 
 
Print Hard Copy 
 
 Click Edit and then select Print as shown above. 

 
 Ensure the Estimator Print Options pop-up is correctly selected as shown above. 

 
 Choose the printer you want to use from the drop-down menu. 

 
 Ensure Portrait is selected. 

 
 Click OK. 
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ADDENDUM: Import Excel file 
 

Import an Excel File Introduction 
 
Excel files are sometimes provided separately for a single group of bid items instead of those 
items having been included in the Estimator file with the other bid items.  Examples are Traffic 
Loops and Bridge items.  Excel spreadsheets can be modified so that they can be successfully 
imported into Estimator.  Using the click and drag function, the entire group along with all of the 
bid items can then be added to an existing estimate file.  It is also possible to enter multiple groups 
or even entire projects on a single Excel spreadsheet into Estimator using this same format.  This 
feature is very helpful for Design/Build projects if an Excel file estimate has been provided instead 
of an Estimator file.  Ensure that the group number is correct for each bid item on the spreadsheet 
to be imported with multiple groups. 

 
Edit the Excel file 

 
The Excel file, regardless of its original configuration, will need to be modified for import so that 
the format is exactly like the example below.  (Due to limitations of space it is not possible to 
show all of the column headers in a single screen capture so the image below has been divided in 
two and stacked.)  It is advisable to keep the original spreadsheet unchanged and create a copy to 
edit and import.  There should be no additional rows or extraneous information beyond what is 
contained in these cells.  The column headers from left to right in the first row must be in the 
following order, named exactly as they are in the illustration and following table:  

 

 
 

 
 

COLUMN HEADER COLUMN CONTENTS / EXAMPLES 
Group 
 

Four digit code for the group with zero’s as needed.  
Set the field Number to Text for the zero’s to show up. 

Line Number Leave blank. 

Item 
 

Bid item code, minimum of five digits with zero’s as 
needed 

Unit “EACH”, “LP SUM”, “TON” & etc., depending upon 
the associated unit used for the bid item 
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Item Description Enter exactly as it is used in AASHTOWare Project. 

Supplemental Description Enter if needed. 
Quantity Quantity of material to be used 

Unit Price Do not change price from spreadsheet.  If blank, use 
most recent year’s average unit bid price 

Extension Use the Excel formula function to calculate the total 
price for the quantity. 

Group Supplemental Number Leave blank. 

Fixed Price Flag Enter Y for the following.  Otherwise enter N: 
 
02600 Fabric Geotextile TY IV for Pipe 
10020NS Fuel Adjustment 
10030NS Asphalt Adjustment 
10203ND Pavement Adjustment 
 

Group Description Leave Blank. 

Group Fund Package Leave blank. 

Item Fund Package Leave blank. 

Obsolete Item Flag Enter N 

Hybrid Lump Sum Flag Leave blank. 

Item Notes Leave blank. 

Group Notes Leave blank. 

Group Alternate Code Leave blank. 

 
Remember to use ALL CAPS in the bid item and supplemental descriptions.  Bid item codes are 
a minimum of five digits so use zero’s at the beginning of four digit numbers.  When the Excel 
spreadsheet is ready for import, it should look like the example above the table. 
After editing the Excel file, save and close the file.  Estimator will not import a file that is currently 
open. 
Ensure that you do not have an existing group number in the estimate with the same number as 
the group to be imported. 

 
 

Import Excel File into Estimator  
 

 Close all open Estimate files including the one into which you are importing the new file. 
 

 Under the File tab, select Import.  
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 Locate the file in the local computer interface and double click the file line or click the 
Open button.   

 

 
 

A dialog box appears to ask whether it is a catalog or an estimate that is to be imported.  Click the 
Estimate radio button and then OK. 

 

 
 

The Estimate Import Spreadsheet Wizard dialogue box 
appears. 
 
 Click the radio button beside Item Data. 

 
 Select Sheet 1 regardless of the number of sheets 

are available for selection. 
 
 Click Next. 
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The following screen appears: 
 

 
 

 Click OK.   
 
The new group appears as an estimate. 

 

 
 

 Click on the + beside Estimate Sheet 1.  The estimate opens with the new group, in this case 
Group 0009, containing the Excel spreadsheet information in the Estimator format. 
 

 Open the Estimator file into which you want to add this new group and items.  Have both 
estimates open in the “restore down” size so they are both in the tile mode and visible side by 
side onscreen.  Remember that both Estimator files must have the same catalog associated 
with each of them or they will both lock up as Read-Only files. 

 
 Click and drag the new group into the estimate above the group where it belongs.  

Alternatively, if you drop the group into the “Estimate DE###########” line at the very top 
of the Tree Pane, the group will be added at the bottom of all the groups and you will have to 
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move it or renumber it.  Remember that the final group should always be DEMOBILIZATION 
&/OR MOBILIZATION. 
 
 

If you are creating an entire project estimate from a spreadsheet for a Design/Build project, you can 
work from the newly imported estimate as there is no need to click and drag. 

 

 
 
 Renumber the newly 

imported group so that it is in 
the correct order and type in 
the appropriate group 
Description in the 
Information Pane in the area 
circled in red in the image 
below (upper right side of the 
screen), in this example 
LIGHTING. 

 
 
 

After adding the description, click into the left Tree Pane and the name you entered appears. 
 

 
 

 Close the individual estimate with the single group in it that you created from the Excel file.  
You do not have to save it although you may want to do so. 
 

 Click the File tab and choose Save As to save all of your changes on the complete estimate 
with the newly imported group. 
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ADDENDUM: BID ITEMS REQUIRING A SUPPLEMENTAL DESCRIPTION 
 

BID ITEM CODE DESCRIPTION UNIT 
02545 CLEARING AND GRUBBING LS 
02742 TRAINEE PAYMENT REIMBURSEMENT HOUR 
03000 PRECAST CONC BOX SECT LF 
08160 STRUCTURAL STEEL LS 
10070NS NON-SPEC MATERIAL DOLL 
10299N REIMBURSEMENT DOLL 
21354ND CUT CAP AND BLOCK FORCE MAIN EACH 
21526ND ANCHOR TEE AND BLOCK EACH 
21661ES706 BORE AND JACK PIPE LF 
21679EN FIBERGLASS DRAIN PIPE LF 
21787ED OPEN CUT W/ PVC ENCASEMENT LF 
21788ED OPEN CUT W/ STEEL ENCASEMENT LF 
22012NN CUT AND CAP WATERLINE EACH 
22139NN CONNECT TO SEWER MAIN EACH 
23055N REMOVE LS 
23279EC RETROFIT EACH 
23280EC RETROFIT LS 
23281EC RETROFIT SQFT 
23282EC RETROFIT LF 
23283EC RETROFIT SQYD 
23286EC RETROFIT CUFT 
23294EC TIE LS 
23310EC VALVE BOX EACH 
23532EC INSTALL MANHOLE EACH 
23696EC BARRIER WALL LF 
24020EC PVC TEE EACH 
24295EC CONNECTOR LS 
24451EC CONCRETE CUYD 
24456EC EXPAN JOINT REPLACE 5 ½ IN LF 
24478EC  TEMP BLOW OFF EACH 
24481ED PVC CASING PIPE LF 
24485ED CUT AND BLOCK EACH 
24486ED TEE EACH 
24492EC CLEAN LS 
24518EC CAP AND ABANDON EACH 
24521EC REPAIR EACH 
24522EC REPAIR LS 
24542EC REPAIR LF 
24543EC CLEAN LF 
24544EC REMOVE LF 
24564EN PVC PIPE LF 
24575ES610 HEADWALL EACH 
24580EC CHAIN LINK FENCE LF 
24583EC HDPE PIPE LINER LF 
24595EN ELASTICIZED EPS SQYD 
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24601EC INSTALL EACH 
24605ED RELOCATE EACH 
24617EC INSTALL LF 
24632EC WATER MAIN LF 
24633EC CAP AND PLUG EACH 
24634EC BEND EACH 
24644EC SERVICE TAPPING TEE EACH 
24645EC MDPE PIPELINE LF 
24646EC STEEL PIPELINE LF 
24647EC RESILIENT SEAT GATE VALVE EACH 
24648EC FOSTER ADAPTER EACH 
24662EC CLEAN EACH 
24668EC STEEL ENCASEMENT PIPE LF 
24688EC REMOVE AND REINSTALL LS 
24714EC SANITARY SEWER PIPE LF 
24731EC REMOVE AND RESET EACH 
24746EC STUB OUT EACH 
24751ED REMOVE STORE & REINSTALL EACH 
24753ED CAMERA POLE LOWERING DEVICE EACH 
24770EC METER VAULT AND BYPASS ASSEMBLY LS 
24771EC SEWER LATERAL REPLACEMENT W/CLEANOUT EACH 
24772EC SEWER LATERAL REHABILITATION W/CLEANOUT EACH 
24773EC METER SETTING EACH 
24774EC MJ OFFSET FITTING EACH 
24775EC CLEAR BRIDGE EACH 
24776EC REPOINT STONE MASONRY SQFT 
24777EC SQUARE HINGED LIGHT POLE REPLACEMENT EACH 
24778EC BRIDGE DRAMATIC LIGHTING REPLACEMENT EACH 
24786EN HDPE PIPE LF 
24810ED SIDEWALK FLUME EACH 
30063 ADDITIVE ALTERNATE LS 
30077 ROCK DOWELS EACH 

 

 

 

 

 

 

 

 

 

 


